Canon Macintosh

Image Viewing, Organizing and Editing Software

ImageBrowser
Ver. 6.2
Instruction Manual

In this manual, IB is used for ImageBrowser.
In this manual, the windows used in the examples are from Mac OS X 10.4.

Click on the icons below on the bottom right of the screen to switch
between pages.

@ . GO to next page @ . GO to previous page
@ . Return to a page you had previously displayed

Click on the chapter headings on the right side of the screen to switch to
the contents page of each chapter.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (i) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Main Features of IB

Download images to your computer
Check images

Print images

Organize images

Edit images
Adjust images
Trim images
Insert text
Correct red-eye
Change image size and type

Utilize images
Attach an image to an e-mail
Create wallpaper or a screen saver

Convert images
Change image size and type

Symbols Used -

: Selection procedure for menus that appear on the computer
screen
[ ] :Names of items and menus, buttons, windows, etc. that appear on
the computer screen
< >:Camera switch name or icon, or a keyboard key name
p.**: Reference page (jump to page by clicking)

AL

: Help @< : Tip
: Important information |§| : Helpful information

(=W

Makeup of Each Chapter

Chapter 1 Basic Operation
Starting up and quitting 1B
Downloading images to your computer
Checking images
Printing images

Chapter 2 Advanced Operation
Efficient checking of images
Organizing images
Editing images
@ Utilizing images
® Index printing
Layout printing

Chapter 3 High-Level Functions
» Checking images with high-level functions
@ Organizing images with high-level functions
© Advanced image editing

Chapter 4 Preferences
Settings for all functions

Reference
Solving problems
Uninstalling 1B
System requirements
Supported images
Lists of primary window functions
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Chapter 1 Basic Operation............ccccvveveeevennnnnnnn. 6
Starting UP IB ... 7
Downloading an Image to Your Computer..........ccc........... 7

Downloading Images Using Your Card Reader............. 8
VIeWINg an IMage ....cooeveiieeeeice e e 9
View Images as Thumbnails in the Main Window ....... 10
Changing the Display Magnification ...............ccc....... 11
Enlarging and Viewing Images One ata Time ............ 11
Displaying an Image Across the Whole Window
(Full View Display) .......ccouuuuiiiiiieiiiiiiiiiiiie e 12
Printing an Image........cooovveiii e 13
QUILLING IB ..o 14

Chapter 2 Advanced Operation .............cccceeeeee 15

Checking/Sorting Images..........ccovevveiiiieeeeiieeeeeeiee e 16

Enlarging and Checking Images One at a Time.......... 16
Enlarging a Specific Part of an Image ...................... 17
SOrtiNg IMAQJES......covevviiiiiieee e 17
Extracting Images You Want to Display (Filter Display) .18
Arranging Images in the Main Window..................... 18
Efficiently Checking/Sorting Images ..........cccoeeeeevvvvvinnnns 19

Organizing IMages .......uceiiiiiiiiiiiiiiiee e eeeeeeees 20
Creating a Folder for Saving Images........c.ccccocevvvvnnn.n. 20
MOVING IMAJES ... e 21

Moving Images in Folders ........ccoooovveiiiivicieeceeeee, 21
Changing File and Folder Names for Images.............. 22
Deleting an Image or Folder.........ccccovveieiieviiicineeeeennnn, 23
Registering Frequently-Used Folders as Favorite
FOIEIS. .. 23

Deleting Favorite Folders........cccooovveiiiiveiiiiiieeeeen. 24

Editing an Image..........cooovviiiiiiiieee e 25
Automatic Adjustment Using IB...........cccocvvviiiiiieeennne, 25
Adjusting Color and Brightness ...........ccccevvvvieiieeeenne, 26
Trimming an IMage......c....vceieieiiiiiiiccie e 27
Inserting Text into IMages ...........vveeeeeieevvveeiiccie e, 28
Adjusting Sharpness.........cccoevvveviiiiiiiee e 29
Correcting Red-Eye Automatically...............c..cceeveeennns 30

Correcting Red-Eye Manually .............cccoevvvvviinenene. 30

Utilizing Your IMages..........cceeeeieiiiieiiiee e 31
Viewing Images as a Slide Show ............ccooeeeeeieeeeen. 31
Sending an Image by E-Mail ...........cccccoiiiiinnnnn 33
Creating Wallpaper from an Image.........ccccccevvvvvrnnnnne. 34
Creating a Screen Saver from an Image..................... 35

Printing Multiple Images on One Sheet of Paper
(INAEX PrINtING) «.eeveveiiiiiiiiiiiiiiii e 37

Arranging Images Freely and Printing (Layout Printing). 38
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Chapter 3 High-Level Functions....................... 39
Comparing Multiple Images...........ccccvvviiiiiiiiiiiiiiiieeeee, 40
Viewing Shooting Information for an Image.................... 41

Changing the Size and Type of an Image and Saving ...41

Exporting Shooting Information .............c..cceveeviveennnnnnne. 42
Organizing Images Using High-Level Functions............. 43
Setting Keywords in IMages ........cccevvveeevveeiiiiinnneeeeeee, 43
Entering Comments into Images ........cccooeevvvvevviinnnnnnn. 43
Saving Multiple Images with New File Names............. 44
Classifying Images by Shot Date..........ccccevvvveiiieeeennee. 44
Searching for Images..........cccccviiiiiiiiiiiiiiee, 46
Performing Advanced Editing ..............ccccvvvviiiiiiiiiiiinn 47
Adjusting the Color of an Image in RGB...................... 47
Adjusting the Brightness Level .........cccooovviiieiiviiinnne. 48
Adjusting the Tone CUrve .........cccovevvviei v, 48
Transferring Images to Other Image Editing
SOfWAIE....eeeie e 49
Merging Images to Create Panorama Images............. 50
Adding Sound to Images/Playing Back...............c.ccc....... 51
Adding Sound t0o IMAages .......ccoeeeevveeeiviiiiiie e, 51
Playing Back Sound................ccooviviiiiiiiieeeeeeeee 51

Chapter 4 Preferences......cccccceevvveivieiiiiiinnneenne, 52
PreferenCes .....ovvvveiii e 53
Browser Window Settings.........cccceeveeveeviii v, 53
Viewer Window SettingsS.........coovevveeiieeveeiiiieeeeeiieeeeees 54
Confirmation Dialog Box Settings..........ccccccevvevvevnnnnnn. 54
Processing When Rotating Settings..........cccccceeeeveeeen. 55
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RefereNCe ... 56
TroubleSNOOTING ......cvviiiiiiiiii e 57
Deleting the Software (Uninstalling) .........ccccooeeeiiiiiiinnnnns 58
System ReqUIrEMENtS .......coevveiviiieeeeiie e eeeeie e e e e 59
Supported IMAgES ......covvveie e 59
About RAW Image TasK .......ccouveeiiiiiiiieeeiiiee e, 59
List of Main Window FUNCLiONS ...........cccvvvviiiiiieeeiieiciiinns 60

Preview Mode ..., 60
LISEMOOE ... 61
List of Viewer Window FUNCLIONS..............cceevieeeeiiiiiinnnnns 62
List of Photo Print Window Functions................cccoeevvvneens 63
List of Index Print Window Functions..........cccccccevvvvvvueuee. 64
List of Layout Print Window Functions............ccccccceeeeeeens 65
Contents LOOKUP .....vvieeiiiieeiiie e 66
INAEX . 67
About This Instruction Manual....................cc e 69
Trademark Acknowledgments............ccccevvvvviiienieee 69
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1 Basic Operation

Starting UP IB ... 7
Downloading an Image to Your Computer ................ 7
Downloading Images Using Your Card Reader............ 8
Viewing an IMage ........ooooviiviiiiiiiiie e 9
View Images as Thumbnails in the Main Window ...... 10
Changing the Display Magnification ....................... 11
Enlarging and Viewing Images One at a Time. ........... 11
Displaying an Image Across the Whole Window (Full
VieW DiSplay) ..ccccooeeeeeeieieeeeee e 12
Printing an IMage ..........cccvviiieieieeiii e 13
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Starting up 1B Downloading an Image to Your Computer

Click the icon on the Dock. Connect the camera and computer with the cable provided and
download the images saved on the memory card inserted in the camera.
For downloading images, start up the camera software “EOS Utility” and
use.

Introduction

Table of
Contents

Connect your camera and computer and turn the

camera on. OB1lt§:
When IB starts up, connect the camera and your computer with the pergtion
interface cable provided with the camera and turn the camera on.
Click For detailed instructions on cor.mecting your camera and A
computer, refer to the “EOS Utility Instruction Manual” (PDF Operation
' ' electronic manual).
IB starts up and the main window (browser window) appears.
High-Level
Functions
Main window (browser window) s Preferences
Reference
=»EOS Utility starts up automatically.
EOS Utility
8en00n EOS Utility - EOS XXX Contents
Lookup
Control Camera Accessories
Starts to download images Index
S ® 8 @ ‘ “ o 1 - Lets you select and download images

Camera settings/Remote shooting @ @

Monitor Folder @
® The [CANON iMAGE GATEWAY] button may not be displayed i ]
depending on the area you are in.
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Introduction

Download images. Downloading Images Using Your Card Reader
- — You can also download images to the computer using a third-party card
Control Camera Accessories reader. gggtlgn(;fs

Start up IB and then select the save destination for

arts to download images CI|Ck . . . .
e ? the images in the folder area at the left of the main 5 B1|g:
: per@tion
Lets you select and download images win d ow.
(@06
Camera settings/Remote shooting Images acquired from your camera Advan(_:ed
can be accessed here. Operation
Monitor Folder
. = T — High-Leve
Favorite F A F i
avorite Folders | al = Functions
_ : : ¥= Macintosh HD
Downloading of images begins. » (A Applications
The downloaded images are saved in the [Pictures] folder and [ Photo Preferences
are displayed in the main window of IB. V& Users
The downloaded images are sorted into folders by date and v {§! canon
saved. g Desktop
. - . . B sy
Click the EOS Utility [Quit] button to quit EOS Utility and turn the = M';?i':;ems Reference
camera’s power switch to < OFF >. - Click
#{__ Shared
Contents
Lookup
Load the memory card into the card reader.
Index

00

Using EOS Utility to download images makes it easier to organize your Download images window appears.
images as they are downloaded, sorted and saved into folders by date. 3

-I\@/i- Advantages of using EOS Utility to download images




Download images.
Download images window

ImageBrowser Canon

[ Download Images ] Click

)

Lets you select and
download images

[ Print Menu ]

Preferences... Exit

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of IB.

The downloaded images are sorted into folders by date and
saved.

Click the [EXxit] button to quit Download images window.

-2\@/3 Advantages of using IB to download images

Using IB to download images makes it easier to organize your images
as they are downloaded, sorted and saved into folders by date.

Viewing an Image
Images downloaded to your computer are displayed as thumbnail

images in the main window. You can double-click a thumbnail to open
the viewer window and display the image at a larger size.

Main window

@ ImageBrowser File Edit View Inemer wWindow Help

4 TueloosaM @

IMG_D001
KKK KK
ToME
IBEE 2 2502
wo

1C D003 PG

st i || 1 2 El
Canaln sl Print & Email Sered 42 Teash
CATERAT

o, of by Sobested | Total §8 imager

Click to select the image | The clicked image is enlarged and

displayed in the center of the window

Displays the images in the folder that was selected
from the folder area on the left of the window
To select multiple images, click on the images while holding
down the < 38 > key or < shift > key on the keyboard.
You can select all images in a folder by clicking the [Selecting
Images] button and then selecting [Select All] from the menu that
appears.

ﬁl For a list of main window functions, refer to p.60.
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View Images as Thumbnails in the Main Window

You can change the display mode of the main window to show only a list
of the thumbnail images.

Click the [List Mode] tab sheet.

File Edit View Internet Window Help

kamera [ PreviewMode | List Mode ‘|

Click
The main window display changes to List Mode.

[ B

Main window (List Mode)

@ ImageBrowser File Edit View Inemer wWindow Help

Hew [ v || T A A [ ]| 3 3
e & = =4 ?. = !

Add Fr— Cavon Carmera Wi bt SMeShow  cawonawct  PimBEmi  Send 1o Trash
caTERAT

b of g Bt 1 { Tokal B s

Click to select the image Displays the images in the folder

that was selected from the folder
area on the left of the window

To select multiple images, click on the images while holding
down the < 38 > key or < shift > key on the keyboard.

You can select all images in a folder by clicking the [Selecting
Images] button and then selecting [Select All] from the menu that
appears.

|§| For a list of List Mode functions, refer to p.61.

4 TueloosaM @

)

Introduction

Table of
Contents

ic
Opernation

Advanced
Operation

High-Level
Functions

Preferences

Reference

Contents
Lookup

Index

00
©

10




Changing the Display Magnification
You can change the display magnification of the thumbnail images
displayed in Preview Mode (p.60) and List Mode (p.61).

Change the display magnification.

| | e e EEE
P P &, B

Canon Camera View Image SlideShow CANON iMAGE Print & Email Send to Trash
GATEWAY

Drag left or right

@ You can also change the display magnification by clicking [ = ]
or[ & 1.
-» The display magnification of the images changes.

@ imageBromser Fie Edn View Inemen Window Help 4 TeeloAM @

ane 1 rowsar Wondow

ﬂ

Enlarging and Viewing Images One at a Time

Double-click an image to enlarge.
Double-click

@ ImageBrowser File Edii view [wemer Window Help 4 Teel00aAM @ _
806
mages asquied fom you amera

LT, e —r— AW o || HHE
[ N L., 848 2 BB

=» The viewer window appears.
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Introduction

Click [ €] or [ ] to switch to the image you want to Displaying an Image Across the Whole
display. Window (Full View Display)
Viewer window : : : Table of
5on S — Double-click on the_lmage you want to display Contents
: across the whole window.
806 IMG_0001.JPG (1/16)
ic
Opernation
— Double-click
Advanced
Operation
High-Level
Functions
\_
. | B T— Preferences
R e © You can also display the image across the whole window by
< > # & ®H B @ = ¢ —' cllckl.ng[@%l](Full Screen) op the bottom of the wmdow..
) L - e oipis  orchonie Fasoen Mol =» The image is enlarged and displayed across the whole window.
Image Size 3888 x 2592 | | Display 19% Y Reference

The shooting information is displayed if you click [ % ] (Show
Shooting Information) and select [Show Shooting Information]

from the menu that appears. Contents
To quit the viewer window, click [ ) ] on the top left of the Lookup
window.

Index

? When you display RAW images in the viewer window

The [Show Original Image] button appears at the bottom of the window.
Click this button to display the processed image.

To return to the viewer window, click on the window or press the

@ For a list of viewer window functions, refer to p.62. < esc > key on the keyboard. 1



Printing an Image

This section explains how to print one image on one sheet of paper.

Select the image to be printed.

 ImageBrowser Fde Edn View Intemer
ne

i aeued B i e
£a° b sreeased bare

Click

To select multiple images, click on the images while holding
down the < 3§ > key or < shift > key on the keyboard.

You can select all images in a folder by clicking the [Selecting
Images] button and then selecting [Select All] from the menu that

appears.

Display the print settings window.
Click the [Print & Email] button and then select [Photo Print] from

the menu that appears.

Sealecting Images v |§| E _i

=.| 8§

E Print & Email Send to Trash

Index Print... -
Layout Print...
Create Image for Email...

— 1

Print & Email Send to Trash

The [Photo Print] window appears.

Set the paper size and other settings, and then click
the [Print] button.

Photo Print window
'8 06 Photo Print

Printer

Canon XXX B

Paper size :

Ad

Click [Page Setup] to enable
borderless printing on
supported printers.

Shooting Date/Time

{ None H

Properties !

)
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ﬁl For a list of photo print window functions, refer to p.63.

Preferences
Remove unwanted regions | ok Add some text to print
_g_ of your photo. ¢ ‘ ‘E with this photo. P
i @ Image: 1/1 Copies: 1 2 Total : 1 pages
C g D[P D)) Reference
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Lookup
Index
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Quitting 1B
In the main window, select the [ImageBrowser] menu
» [Quit ImageBrowser].

ImageBrowser

About ImageBrowser...
Preferences... 3,

Services >

Hide ImageBrowser 3H
Hide Others #EH

Show All

( Quit ImageBrowser  3£Q )

IB quits.

)
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D Advanced Operation —
Introduction

Checking/Sorting Images .........cccceevveevveeiicieeeeeeiinnnn. 16 Utilizing YOUur IMages........ccueiieeiiieiiiiie e 31
Enlarging and Checking Images One at a Time........ 16 Viewing Images as a Slide Show ............cccccceeeeeeee. 31 Table of
Enlarging a Specific Part of an Image ................... 17 Sending an Image by E-Mail ...........ccccccevevieeenennnnn, 33 Contents
SOrting IMAQES......ccvvviiiiei e 17 Creating Wallpaper from an Image............cccceeeevveennns 34
Extracting Images You Want to Display (Filter Creating a Screen Saver from an Image.................... 35 OpBe?Z'tfon
DISPIAY) «eeeeeieee e 18 Printing Multiple Images on One Sheet of Paper
Arranging Images in the Main Window .................. 18 (Index Printing) ..., 37 Ad@ed
Efficiently Checking/Sorting Images............cccccuuuuee. 19 Arranging Images Freely and Printing (Layout Opgdj'on
Organizing IMagES ... .ccveeeeeee e, 20 PriNtiNg) coe e 38
Creating a Folder for Saving Images......................... 20 High-Level
MOVING IMAJES .....oeveveieeieeieieier e 21
Moving Images in Folders..........ccccceeevevvevieeceeennnnn. 21
Changing File and Folder Names for Images............ 22 g
Deleting an Image or Folder ...........cccoeviiiiniiiiiiinninnn 23
Registering Frequently-Used Folders as Favorite Reference
0] [0 [T £ PRSP P 23
Deleting Favorite Folders...........ccccoeeeeieiiee 24
. Contents
Editing an Image ..o 25 Lookup
Automatic Adjustment Using IB ........cccoceeviiiiiiiinnnnnnnn. 25
Adjusting Color and Brightness ...........cccccvvvvviviinnnene. 26 —
Trimming an Image..........cccccovvvviiiiiieeieeeeeeeeeeeeeeeee, 27
Inserting Text into IMages ..........vvvvvvvvviviiiiiiiinns 28
AdjuSting SarpNess.........ccoevvviieiieieeee e 29 @ @
Correcting Red-Eye Automatically...........cccccceeeeeee. 30
Correcting Red-Eye Manually...........cccccvvieinnnnn. 30 @
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Checking/Sorting Images

You can enlarge images one at a time from a list in the main window and
check what they look like in detail, and sort them into one of three

groups with [ ©7 ] (ratings).

Enlarging and Checking Images One at a Time

Double-click on the image on the top left of the main
window.
Double-click

@ ImageBrowser File Edit View fwemer Window Help 4 Tuel00SAM @
[-XsX-]
magos

e
s |
: - ‘:—,

The viewer window appears.

Click [ €] or [ ] to switch to the image you want to
display.

Viewer window

(@66 & IMG_0001.JPG (1/16)

L N Fit to window ANy B
T 7 & 8.8, 8 3 % 9

-
Show Shoating
Back Next Save chronize  Full Sereen Print i

Displays b

)

Introduction

Table of
Contents

Basic
Operation

Image Size: 3888 x 2592 | | Display 19 % 4

© The shooting information is displayed if you click [ =& ] (Show
Shooting Information) and select [Show Shooting Information]
from the menu that appears.
To quit the viewer window, click [ €3 ] on the top left of the
window.
When checking RAW images, always click on the [Show Original
Image] button and check the processed images.

=@< To display only selected images in the viewer window

Select multiple images in the main window (p.10) and then click on

onIy the selected i |mages in the viewer window.

|§| For a list of viewer window functions, refer to p.62.
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Enlarging a Specific Part of an Image

Enlarge an image.
Click the list box and then select the display magnification.

+ Fit to window
200%
175%

150% 5
( Fit to window H—-J] e ! 125% R S
= e 1 100% | =
[& d - = | ; &
Save Edit NS:‘::;;;? Synchronize g : 50% Synchronize
25%

The image enlarges and the navigator window appeatrs.

Display the part of the image you want to check.
Drag the enlargement display position in the navigator window
and display the part of the image you want to check.

Navigator window

Enlargement
display position
Drag to move the
display position

Display magnification
To return to full view, select [Fit to window] from the list box.

? Enlarging RAW images

RAW images cannot be enlarged before they are processed. By clicking
the [Show Original Image] button on the bottom of the window, the
image is processed and it can be enlarged.

Sorting Images

You can sort images into one of three groups by attaching [ 1’7 ] (ratings)

)

Introduction

according to photo subject or theme. Please note that [ 7777 ] is (-:rgrtm)':gnotfs
automatically attached to images shot with your camera.
Increase or decrease a rating. Basic
Click the list box and then select the number of [ 77 ]. Operation

dow I--i“r TOLT I-E"_
h. BEe & 3 0T

Number o i .
lays Synchronize  Full Screen Print]

L &

—
Print

L e
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Click the [ ] button.

ofE e ) R A [ [T S
) 4 @, & 8

Canon Camera View Image SlideShow CANON IMAGE Print & Email Send to Trash
CATEWAY

The extract function appears.

Checkmark the number of [ 1.7 ] you want to extract

and display.

Filter by Star Rating i E i E WO @ b g g )

vl [F owre]|TTOTTT A Q[ ]| 6 @ W
=, = y - : 3
. . &

Canon Camera View Image SlideShow CANOM IMAGE Print & Email Send to Trash
GATEWAY

Only the images with the number of [ 57 ] you have checkmarked

are displayed in the main window.
To quit the extract display, click the [
again.

Extracting Images You Want to Display (Filter Display)

You can extract images displayed in the main window by the nhumber of
[ 7.7 ] you have attached to them (ratings).

Arranging Images in the Main Window
You can arrange images in the order of file size or shot date and time.

Select the [View] menu P> [Sort] P> desired item.

View
View Mode >
View Settings >
0 v File Name
. File Modification Date
Display > File Size
E'?I_flrge ?h Shooting Date/Time
Reduce = Type
View Actual Image | v Ascending
Show AF Frame Descending
Show Shooting Infarmation
Slide Show...
Slide Show Options...
Refresh #R
=» The images are arranged in the order according to the selected
item.
Sort item Description

File Name Image file names are arranged in the orderof 0 —9 - a —z.

File Modification Images are arranged in the order of most recently
Date updated.

File Size Images are arranged in the order of the smallest file size.
Shooting Images are arranged in the order of most recently shot.
Date/Time

Type Images are arranged in the order of BMP images - RAW

images = JPEG images — PICT images — TIFF images.

Images are arranged from top to bottom in order of
sorting criteria.

Images are arranged from bottom to top in order of
sorting criteria.

Ascending

Descending
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Efficiently Checking/Sorting Images .
Introduction
With Preview Mode that displays images as thumbnails and as single Click on athumbnail image to switch to the image
images in the same window, you can sort images by the number of [ 77 ] you want to check, and then sort with the number of
while checking efficiently. You can also simultaneously check shooting [ 4] Table of
information for images. ' _ antgnots
' Select the number of [ 1’7 ] from the list
Enable PreVieW MOde' Plr?n:/g:meuwvs\ell I:fel()hf iew Inerner  Window  Help 4 Tue 10009 AM @)
File Edit View Internet Window Help E— OpBe?Zic(izon
hamera [[—Pr!w:wﬂndt—rl List Mode e
= | Advaficed
— ~ Opegition
Click '

The main window display switches to Preview Mode.

High-Level
Functions

¥ Wepword

(_ viewiModify Keywords )

i \ Preferences
NG D305 MG TS D006

- -uc_g,w. DI IWE_ D3RG
v [F T R R [ ] 333 Reference

> @ o 9 @, B

I_ x5 - Cavon Carara View [mage SideShon b & Emal  Sofd te Trush
The selected image in the thumbnail (iontlc(ants
image display area is enlarged in ookup
the center of the window

Thumbnail image display area Index

When checking RAW images, always click on the [Show Original —
Image] button in the viewer window and check the processed

images. @ @

ﬁl For a list of Preview Mode functions, refer to p.60. 19



Organizing Images
This section explains functions that are useful for organizing images

such as creating new folders for saving sorted images, moving and
copying images and deleting unwanted images.

Creating a Folder for Saving Images

You can create a folder to save sorted images.

In the folder area, select the location where the new
folder is to be created.
(@06

Images acquired from your camera
can be accessed here,

" Favorite Folders | All Folders ]

B & Applications
[Z Photo
¥i.& Users
¥4l canon
b Documents
Lﬂ Maovies

»[ 3 Shared

Select the [File] menu P [New Folder].

Open... #0

Close BEW

Save #S

Save As... + 385
' New Folder QEI\D

> >

Get Info... A

Copy Image...

Move Image...

Duplicate %D

Rename...

Send to Trash e

Search... 3%F

Export Image...

Organize Image »>

Process RAW Images by Digital Phota Professional...

Connect to Camera...

Rewfite Imageto Memory Card...

Print >

Sound

=» The [New Folder] window appears.

2 Enter a folder name and click the [OK] button.
=» The new folder is created in the folder selected in step 1.
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Moving Images

You can move or copy images to separate folders and organize them
according to shot date or theme.

Moving Images in Folders

You can move or copy folders that contain images, and organize images
in folders.

Drag the image to be moved or copied.
To move:Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the < option > key

and release when the image is in the destination folder.

-
8eoe
Images acquired from your camera ( Preview Mode !--———h-:r-Moﬂe-——-—-]

can be accessed here.

Favorite Folders | AllFojflers )

¥ = Macintosh HD
BN Applications
¥|.& Users

v §i canon

>

" Photo

XXX MM _XX

L:; xxxx_xx_01
[0 sxxx_xx_02
[ oo _xx_03 4
[ xxxx_xx_04 - g A\

IMG_0006.JFG

The image is moved or copied to the folder it was dragged to.

Drag the folder to be moved or copied.
To move:Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the < option > key
and release when the folder is in the destination folder.

-

8ece

Images acquired from your camera ( Preview Mode F-—-——hsr-Mode“-—v]
can be accessed here.

| Favorite Folders | All Folders ~ )

¥ Macintosh HD
»[ A Applications
V& Users
¥&icanon
-l Desktop
»| ¥ Documents
@Movies
TfﬁPiclures
" iPhoto Library

| XXX _XNX_XX

[ xxxx_xx_02
[ sooxx_xx_03

[ xocxx_xx_04

IMC_0006 PG

N
was dragged to.

The folder is moved or copied to the folder it
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Changing File and Folder Names for Images

In the main window, select the image whose name
you want to change, or, in the folder area, select the
folder whose name you want to change.

Select the [File] menu P> [Rename].

Open... #0
Close aBw
Save #5
Save As... >3k
New Folder 3#N
Favorite Folders »>
Get Info... 31
Copy Image...
Move Image...
i 2 98
' Rename... \2
nawo rrdsn &b
Search... 3HF
Export Image...
Organize Image »>
Process RAW Images by Digital Photo Professional...
Connect to Camera...
Rewrite Image to Memory Card...
Print b
Sound

The [Rename] window appears.

Enter the file or folder name of the image and then

click the [OK] button.
Rename window

r
Rename

File Name] Photo

( Cancel )

The file or folder name changes to the new one.

You can also change the file name in the [File Information]
window (p.41) or in the information display area (p.60) in Preview

Mode.

You can also change the folder name in the [File Information]

window (p.41).
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Deleting an Image or Folder

Deleted images and folders cannot be recovered. Also, take care when
deleting folders as all the images inside a folder will also be deleted.

In the main window, select the image you want to
delete, or in the folder area, select the folder you
want to delete.

Click [Send to Trash].

|
| Salecting Images ‘.‘| E .E ....J

L= 3
ACE Print & Email Send to Trash
'

The image or folder is moved to the [Trash] and is deleted from
IB.

If the [Move to Trash?] dialog box appears, click the [Yes] button.

To delete an image or a folder from your computer, on the
desktop, select the [Finder] menu » [Empty Trash].

Registering Frequently-Used Folders as Favorite Folders

You can register shortcuts for frequently-used folders in the [Favorite
Folders] tab sheet in the folder area to make images easier to find.
Please note that because the [Pictures] folder is registered as a favorite
folder by default, the folder icon appears as [ | ].

Select the folder you want to register.

Images acquired from your camera
can be accessed here.

" Favorite Folders | Al Folders ]

¥.=! Macintosh HD
B[ ¥ Applications
Y& Users
¥ {§} canon

b i Documents
[Z Movies
[ Pictures

‘ Add to Favorites |

Click the [Add to Favorites] button.
The folder icon changes to [L_‘éf ] and the folder is registered as a
favorite folder.
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Introduction

Select the [Favorite Folders] tab sheet. Deleting Favorite Folders
If you no longer need a folder you have registered in the [Favorite
Select the registered folder to display the images Folders] tab sheet, you can delete it from this tab sheet. Table of
inside the folder. Please note that as registered folders are shortcuts, the original folder Contents
will not be deleted when you delete the shortcut.
Images acquired from your camera
can be accessed here. . Basic
In the [Favorite Folders] tab sheet, select the folder o B
(Favorite Folders | All Folders | you want to delete and then click the [Remove]
(2 Movi button.
e e — Click Images acquired fram your camera
‘21 Pictures can be accessed here.
[ Favorite Folders | All Folders
-  — High-Level
ﬁ Functions
P 22 Pictures
Preferences
E = <[>
Favorites Reference
Add... | ‘ Remove
. L . ! Contents
The images inside the folder appear. = e Rl Lookup
Favorites
Add... ‘ | Remove
Index

The folder is deleted.

? If you have edited or deleted images in folders you have @ @

registered as favorites

Any changes done to images inside registered folders will be applied to @
the original images. Therefore, please be aware that by editing or
deleting images inside registered folders, you are in fact editing or
deleting the original images. 24



Editing an Image

If the brightness or color of images is different from what you visualized
when you shot the photo, you can adjust an image using the editing
functions to bring them closer to what you visualized.

This section explains about automatic adjustment of images, adjustment
of brightness/saturation, trimming images, inserting text into images,
adjustment of sharpness and red-eye correction.

JPEG images deteriorate slightly when edited and saved, and the image
before editing cannot be recovered. For this reason, an edited JPEG
image should be saved as a separate image from the original image.
Chapter 3 explains about high-level editing functions other than those
described above.

|§| You can edit RAW images in Digital Photo Professional (hereinafter,
“DPP"). Select the RAW image in the Main Window and select the
[File] menu P [Process RAW Images by Digital Photo Professional],
which will start up DPP. For detailed instructions on using DPP,
refer to “Digital Photo Professional Instruction Manual” (PDF
electronic manual).

Automatic Adjustment Using IB

The brightness and colors, etc. of the image are automatically adjusted.

Display the image to edit in the viewer window (p.16).

Click [Edit] and then select [Auto Adjustment] in the
menu that appears.

Triming Image...
Color/Brightness Adjustment...
Red Eye Correction...

Insert Text...
Level Adjustment...
Tone Curve Adjustment...

Auto Adjustment... )

it to window L I [ it 7 FRET
o +] ==  Edit with Registered Application (!
2 e I
8|l & 3 _— T
Number of 5 Number of .
Edit Displays Synchronize Full Screen Edit Displays Synchronize Full Screen

Click the [Auto Adjust Image] button.
Auto Adjustment window

Auto Adjustment

( Auto Adjust Image 3

Undo

{ Cancel |

Display Size: 3888 x 2592 |

=» The image is adjusted.

Check the adjustments.

" Show Original Image

Display Size: 3888 x 2502

The [Auto Adjustment] window appeatrs.

Checkmark to display the image before adjustments

Click the [OK] button.
The [Auto Adjustment] window closes.
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Save as a separate image.
In the viewer window, click [Save].

Fit to window [ A

ﬁ ._‘iﬁ = i
‘ ’ A ~ Nu:t:r D? ==
Back Next Save Edit Displays Synchro|

3888 x 2592 |

The save dialog box appears.

Enter a new name, specify the save location and then
click the [Save] button.

Enter the new name  Specify the save location

(0©e 6 IMG_0001JPG (1/16)

Adjusting Color and Brightness

You can adjust the brightness and color (saturation) of images.

Save As: | IMG_0001 ™

Where: [@E Desktop [ i

Image Type: Exif JPEG [l :}

Show Shooting
Infarmation

Back Next Save Edit

Image Size: 3888 x 2592 ‘ ‘ Display. 22% Z

The edited image is saved as a separate image from the original
image.

Display the image to edit in the viewer window (p.16).

Click [Edit] and then select [Color/Brightness
Adjustment] in the menu that appears (p.25).
The [Color/Brightness Adjustment] window appears.

Select the [Color Adjustment] tab sheet and adjust
the image.
Color/Brightness Adjustment window

Color/Brightness Adjustment

[RGB Adjustmeml\ Color Adjustment ]—'—

Saturation q'_'? 0 ?

I 1 1 I 1 I 1 I ~

Brightness - 0 2

- t

I~ Show Original Image Undao All Undo Redo
(| Cancel ) (—6*—3
Display Size: 3888 x 2592

Drag to the left or right to adjust

Move the slider to the right to make the [Saturation] of an image
to appear more vivid and the [Brightness] appear brighter. Move
the slider to the left to make the [Saturation] of an image weaker,
and the [Brightness] of an image appears darker.

The image is adjusted.

Check the adjustments and then click the [OK]
button.

Save the image as a separate image (Description on the
left).
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Trimming an Image

You can trim only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical.

Click the [Trim Image] button.

Display the image to edit in the viewer window (p.16).

Click [Edit] and then select [Trim Image] in the menu

that appears (p.25).
The [Trim Image] window appears.

Drag the trimming range.
Trim Image window

-

Trim Image

The image will be trimmed to the area shown
inside the trim box.

1. Move and resize the trim box in the
preview area.

( Advanced Options )

2. Click Trim Image to apply the settings.

( Trim Image )

m@ :,{a @‘ 3. Click OK to close the panel.

&
Display Size: 3888 x 2592 | X 389 Y 259 W 3110 H 2074 |Zﬂ»ﬂmhtm 10%

Drag

The trimming range can be moved by dragging.
You can change the trimming range by dragging the four corners
and the four sides of the trimming range.

2. Click Trim Image to apply the settings.

[( Trim Image )]

Undo Redo

3. Click OK to close the panel.

The image is trimmed.

Check the trimming and then click the [OK] button.

Save the image as a separate image (p.26).
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Inserting Text into Images

You can insert the date and time you shot an image and text into an
image as text.

Display the image to edit in the viewer window (p.16).

Click [Edit] and then select [Insert Text] in the menu

that appears (p.25).
The [Insert Text] window appears.

Drag the range for inserting text.

Insert Text window

Using the keyboard, enter the text you want to insert.

@Antialias

Text:
7

Import Comment

=
<

Import Shooting Date/Time )

-

Insert Text

Show Original Image

Font Name: Geneva H]

Font Size:

72
Text Color: lil
rex B

EAmiaIias

Text:

Import Comment

( Import Shooting Date/Time )
Fit to window =0 ] a8 @

Undo All Undo Redo

( Cancel )( 0K )

Display Size 3888 x 2592

| Display 9%

Drag

The text insertion range can be moved by dragging.
You can change the text insertion range by dragging the four
corners and the four sides of the text insertion range.

The text you enter appears in the window.

Check your entry and then click the [OK] button.

Save the image as a separate image (p.26).
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Adjusting Sharpness

You can make the overall atmosphere of an image harder or softer.

Display the image to edit in the viewer window (p.16).

Click [Edit] and then select [Sharpness] in the menu
that appears (p.25).
The [Sharpness] window appears.

Adjust the image.
Sharpness window

Sharpness

[-Sharperr 1

Undo All Undo 1€ Redo ;]

| Show Original Image

( Cancel )‘l—’

Display Size: 3888 x 2592

Drag right to adjust

Move the slider to the right to make an image harder and to the
left to make an image softer.
The image is adjusted.

Check the adjustments and then click the [OK]
button.

Save the image as a separate image (p.26).
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) Introduction
Correcting Red-Eye Manually

You can manually correct red-eye that cannot be corrected
automatically. Table of
Contents

Correcting Red-Eye Automatically

You can automatically detect and correct red-eye that occurs when you
photograph people using a flash.

Display the image to edit in the viewer window (p.16).

Click [Edit] and then select [Red Eye Correction] in
the menu that appears (p.25).

Display the [Red Eye Correction] window (Description
on the left).

Display the image enlarged and then select [Manual
Mode].

Basic
Operation

The [Red Eye Correction] window appears. Red Eye Correction
@ Auto Mode C sart )
Click the [Start] button.
() Manual Mode
Red Eye Correction window
Red Eye Correction H|gh_Leve|
@ Auto Mode (T) Functions
() Manual Mode
Preferences
(Fi[(nwindow M a q
— ShowOriginal Image Undo Al Undo Redo
( Cancel ) ( oK )
Display Size: 1728 x 1152 Display: 21% Referen Ce
=Sl Er e Undo Al Undo O Eeto Display the image enlarged
Display Size: 1728 % 1152 I. D\s::'nCEI ) ( 21% ; Contents
. . Lookup
The image is corrected.
Check the corrections and then click the [OK]
button. Index

Save the image as a separate image (p.26).
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Click on the places in the image you want to correct.
When you move the mouse cursor on the places to be corrected,

[ ()]is displayed.

Red Eye Correction

() Auto Mode Start

m ® Manual Mode

__| Show Qriginal Image Undo Al Undo ( Redo J

( Cancel :)( 0K )

Display Size: 1728 % 1152 Display: 175%

Click

The image is corrected.

Check the corrections and then click the [OK]
button.

Save the image as a separate image (p.26).

Utilizing Your Images

You can view your images as a slide show, send them in an e-mail or
use them as wallpaper or screen savers for your computer.

Viewing Images as a Slide Show

You can display selected images across the whole window and switch
between them as a slide show.

Select images.

Select the [View] menu P> [Slide Show Options].

View Mode

View Settings
Sort

Display
Enlarge *+
Reduce ¥—

View Actual Image
Show AF Frame
Show Shooting Informartior

Slide Show...
[ slide Show Options... )

Refresh #R

The [Slide Show Options] window appears.
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Set the play method and transition effect for the slide

show and then click the [OK] button.
Slide Show Options window

-

Slide Show Options

Play Method
®) Auto Play

Play Interval -G’ Simas

O Control with Mouse or Keypad

[ Repeat Continuously
1 Hides buttons

Transition Effect

( (None) H']

@ ( Cancel }( oK

=» The [Slide Show Options] window closes.

4 Click [SlideShow].

i = & V. &

n Camera View Image SlideShow CANON IMAGE Print & H
GATEWAY

-» The Slide Show window appears and the slide show begins.

Slide Show window

.
Rating setting ——
Selects the image**
Prints the image*?
Switches to the first image

Switches to the previous image —

(oo ™ o = | @ @M M |

Ends the slide show

Switches to the last
image

Switches to the next
image

Pauses the slide
show

*1 The image is selected. When the slide show ends and returns to
the main window, the image is displayed as being selected.

*2 The image is selected for printing. When the slide show ends and
returns to the main window, the print dialog box is displayed.

=»When all the images have been displayed, the Slide Show
window closes and returns to the main window.
@ To end the slide show half-way through, click [Q ]

G
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Sending an Image by E-Mail

You can attach a selected image to an e-mail and send it.
The attached image to be sent is a copy of the original image and
therefore the original image remains unaffected on your computer.

Select an image.

Click [Print & Email] and then select [Create Image
for Email] in the menu that appears.

Salecting images v |§| El _l
~.| &

E Print & Email Send to Trash

. 4

Photo Print...
Index Print...
< __Layout Print...

j Create Image for Email... !

Print & Email Send to Trash

The [Create Image for Email] window appears.

Select [Using the recommended settings.] and then
click the [Finish] button.
Create Image for Email window

Create image for Email

Image Settings It is recommended that

the total file size of

(8 Using the recommended set(ings.) attachments be limited
to 1 MB or less.

) Using custom settings. To reduce file size, carry

out one of the

T operations below.

~Reduce the number of
p Confirm Current images selected.

~Click the [Custom
Settings...] button and
adjust settings.

Cancel ) '\’ Finish \l'

The image is displayed in the main window and the e-mail
software starts up.

© Attach to the e-mail [Email Images] in the folder area and then
send the e-mail.
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Creating Wallpaper from an Image

You can make a selected image wallpaper for your computer.
The JPEG image for the wallpaper (extension “.JPG") is created using a
copy of an image and therefore the original image remains unaffected.

Select an image.

Select the [File] menu P [Export Image].

Open.. HO

Close *’W

Save ER

Save As... gigt: ]

New Folder #N

Favorite Folders 2

Get Info.. £

Copy Image...

Move Image...

Duplicate #D

Rename...

Send to Trash xr@E

Search... #®F
‘ Export Image... )

fganize Image 1.

Process RAW Images by Digital Photo Professional...

Connect to Camera...

Rewrite Image to Memory Card...

Print >

Sound >

The [Write a still image] window appears.

Select [Export an Image as Wallpaper] and then click
the [Next] button.
Write a still image window

Write a still image

@ Edit and Save Image

Converts images to a different image type or changes the size.
Movie images or RAW images cannot be exported.

() Export Shooting Properties
Exports the Shooting properties of the selected image to a file.

() Export as a Screensaver

Creates a screen saver from the image.
Movie images and RAW images cannot be exported.

(C Export an Image as Wallpaper)

The image will be made so you can use it as Wallpaper.
Movie images and RAW images cannot be used as Wallpaper.

The [Set Image as Wallpaper] window appears.

From the list box, select the wallpaper display
method and then click the [Finish] button.
Set Image as Wallpaper window

Set Image as Wallpaper

Sets the image as Wallpaper

Specify Display Method [ Fit to Screen | C!)

Cancel ) ( <Back \'\( Finish )

The image you selected for your wallpaper is applied as
wallpaper.
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? To revert to the original wallpaper

On the desktop, launch [System Preferences] from the Dock and then
click [Desktop & Screen Saver].

Select the [Desktop] tab sheet.

Select the file for the wallpaper and then click [ €3 ] to close the dialog
box.

Creating a Screen Saver from an Image

You can make a selected image a screen saver for your computer.
The data for the screen saver (extension “.SLIDESAVER”) is created
using a copy of an image and therefore the original image remains
unaffected.

Select an image.

Select the [File] menu P> [Export Image].

Open... #0

Close BW

Save 5

Save As... 385

New Folder #EN

Favorite Folders >

Get Info... *

Copy Image...

Move Image...

Duplicate %D

Rename...

Send te Trash L)

Search... %F
' Export Image... )

ganize Image .3

Process RAW Images by Digital Photo Professional...

Connect to Camera...

Rewrite Image to Memory Card...

Print »

Sound >

The [Write a still image] window appears.
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Select [Export as a Screensaver] and then click the

[Next] button.

The [Export as a Screensaver] window appears.

Using the keyboard, enter a name and then click the

[Finish] button.
Export as a Screensaver window

rB 086 Export as a Screensaver

The selected image will be exported as a screen saver.

Mame of Screen Saver

IB_ScreenSavers

Save To

Macintosh HD:Users:canon:Library:Screen Savers

F g

[ Cancel ) [ <Back :1[\ Finish

)

A

The screen saver data is saved in the [Screen Savers] folder.

Specify the saved screen saver on your computer.
On the desktop, launch [System Preferences] from the Dock and
then click [Desktop & Screen Saver] P> [Screen Saver] tab sheet

to display the [Screen Saver] tab sheet.

8680 Desktop & Screen Saver
&

{ Desktop | Screen Saver }

Screen Savers Preview
(MR Toest
@ iTunes Artwork
@ Nature Patterns
’a Paper Shadow
WA RSS Visualizer
WA Spectrum
ﬁ -Mac
,\:J Pictures Folder
I E’q Choose Folder...

' ﬁ IB_ScreenSavers ':

A
L (!

[_] Use randofm screen saver ( Options... ) C Test

)

Start screen gaver: —6—
| ! 1 | | 1
3 5 15 30 1hr  Zhr Never

( Hot CnrnEID

@

Select the saved screen saver data

o Close the [Desktop & Screen Saver] window.

Click [ €% ] on the top left of the dialog box.

)
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Printing Multiple Images on One Sheet of Paper (Index Printing)

You can arrange multiple images in index format and print them on one

sheet of paper.

Select the images.

Click the [Print & Email] button and then select
[Index Print] from the menu that appears.

Specify settings such as the paper type and the
number of prints, and then click the [Print] button.

Index Print window

(@O0

Index Print

Photo Print...

( index Print... )

Salecting images v | El m _i 5ol LaYOUI Print...
I  Create Image for Email...
| 8

E Print & Email Send to Trash Print & Email Send to Trash

———

The [Index Print] window appears.

Printer

Name:

Canon XXX |-'3"!

Paper size :
Ad
Orientation: Portrait

On printers that support borderless
printing, this feature is not
recommended.Click [Page Setup] to
change this setting.

[ Page setup...

Preview

)
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"l Header / Footer g‘ § -E!
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: : Contents
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Arranging Images Freely and Printing (Layout Printing)

You can lay out images freely and then print them.

Select the images.

Click the [Print & Email] button and then select
[Layout Print] from the menu that appears.

Salecting Images v |§-| E :L‘J

b S

E Print & Email Send to Trash

|
Seh

Photo Print...
Index Print...

(_ Layout Print... ,
Create Image for Email... |

W

Print & Email Send to Trash

The [Layout Print] window appears.

Lay out your images by dragging them and then click

the [Print] button.
Layout Print window

Orientation: Portrait

Click [Page Setup] to enable
borderless printing on supported
printers.

(6 o6 Layout Print

Print Style Preview

Custom layout printing FH
Printer —
Name:
" Canon XXX >+j

( Page setup... )

Paper size :
Ad

&

Rotate Left

Rotaj

R = g &

te Right Trim Image Images Re-Layout Clear
per Page

( Close ) ( Save 1( Print ))4

)
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3 High-Level Functions

Comparing Multiple Images.........ccccvvvevvciieevveennnnnn. 40
Viewing Shooting Information for an Image............. 41
Changing the Size and Type of an Image and
SAVING ottt 41
Exporting Shooting Information ..............cccccco.cooe. 42
Organizing Images Using High-Level Functions ..... 43
Setting Keywords in Images...........cccccvvvvviiiiiiiiiennnnne. 43
Entering Comments into Images ...........ccccccvvvvveeeenene. 43
Saving Multiple Images with New File Names............ 44
Classifying Images by Shot Date...............ccccevvvveeeene. 44
Searching for IMages .........ccccevvvvieiiiiiiieiiiiie 46
Performing Advanced Editing .............cccceevvvvvvviinnnns 47
Adjusting the Color of an Image in RGB..................... 47
Adjusting the Brightness Level ..........ccccoveviiiiiiiinenenn. 48
Adjusting the Tone CUurve ... 48
Transferring Images to Other Image Editing Software... 49
Merging Images to Create Panorama Images............ 50
Adding Sound to Images/Playing Back ................... 51
Adding Sound t0 IMAageS .......ccoeviiiiiiieie e 51
Playing Back Sound ............ccccceeieiiieiieeeiieneee e, ol
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Comparing Multiple Images

To compare multiple images, you can split the viewer window into two,
three or four and display multiple images at the same time.

You can also align the display position of enlarged images and compatre.

Click [Synchronize] and then enlarge the image.

In the main window, select the images you want to
compare (p.10).

Click [ /] (View Image) (p.61).
The viewer window appears.

Click [Number of Displays] and select the number of
images you want to display at the same time.

‘ + Single View
2-Page View (Arrange horizontally)
2-Page View (Arrange vertically)

B ort,

Fit to window

g - . | 3-Page View
7 : L 4-Page View
Fit to window ey B | 9
.
3 g i =1 Number of

Fa % Edit Synchronize Full 5 Print

7 ﬁ e Nur DT LeJ E e ’

] Edit Displays Synchronize  Full Screen ‘ Display

The viewer window is split and the multiple images are displayed
at the same time.

v

Example of display when [4-Page View] is selected

ans | pletures.
IMG_0101JPG (1/4) IMC_0102.JPC (2/4)

=) = :
N&T;;;? Synchronize §  Full Scredn Print s"\':;:ri::ﬁ::g
| Display 10%
Click Select the display magnification

age e Y504 % 2136 gy

The synchronize display appears and all the images are displayed
at the same display magnification and in the same position.

The navigator window that displays the enlargement display
position appears and you can check and move the enlargement
display position (p.17).

Click [Synchronize] again to cancel the synchronize display. You
can now change the display magnification and move the
enlargement display position for each image.

To return to full view, select [Fit to window] from the list box under
each image.

To cancel the split display, click [Number of Displays] at the bottom of
the window and then select [Single View] from the menu that appears.

)
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Viewing Shooting Information for an Image
Display List Mode (p.61).

Select the image for which you want to view the
information.

Select the [File] menu P [Get Info].
The [File Information] window appears.

Click the [Advanced View] button.

(" Advanced View )

File Name: IMG_0001

I I Spg 1¢- SnnT IA.rn.c ANl

v

re © © File Information

¥ Star Rating 'r
(e B

¥ Comment

(" Hide Detail )

—
| File Name: IMG_0001
¥ Keyword hL Modified: XXX RN KKK KX
e “ File Size: 7.0 MB (7,302,842 B
[ View/Modify Keywords... ) e { ytes)
Image Size: 3888 x 2592
¥ Brightness Histogram Dara Type: JPG
Sound:
Lock: M/
v ( < Back ) ( Next > )
|

|§| In Preview Mode, the same information as the [File Information]
window is displayed on the information display area (p.60).

Changing the Size and Type of an Image and Saving

You can change the size of an image or convert it to a TIFF image
(extension “.TIFF”) or a PICT image (extension “.PCT”) and save it.
Because the image is saved as a separate image, the original image
remains unaffected.

Select an image.

Select the [File] menu P> [Export Image].
The [Write a still image] window appears.

Select [Edit and Save Image] and then click the
[Next] button.

Write a still image

(8 Edit and Save Image]

Converts images to a different image type or changes the size.
Movie images or RAW images cannot be exported.

() Export Shooting Properties

Exports the Shooting properties of the selected image to a file.

() Export as a Screensaver

Creates a screen saver from the image.
Movie images and RAW images cannot be exported.

() Export an Image as Wallpaper

The image will be made so you can use it as Wallpaper.
Movie images and RAW images cannot be used as Wallpaper.

The [Edit and Save Image] window appears.
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Exporting Shooting Information

Specify the image size, type, file name and save You can export as a text file the shooting information recorded to the
destination, and then click the [Finish] button. Image.
Edit and Save Image ) .
[ Resize the image Select an Image.
) Specify the length dimension PIXES
R Select the [File] menu P [Export Image].
B = ; The [Write a still image] window appears.
Iy - High . . .
= Select [Export Shooting Properties] and then click
niial text o the [Next] button.
NEW o el The [Export Shooting Properties] window appears.
Example: NEW0O0O1.JPG
. Specify the export shooting information, the file
e P name, and the save destination, and then click the
Save To:MacOSX Users:canon:Pictures:xxex_xx_0ocxxxx_xx_01 |"IW"\ [ FI n I S h] b U ttO n .
— = (@06 Export Shooting Properties )
Cancel B < Back ] ( Finish )
Select the image info to be written.

. . . o Creates a text file in which item names and values are tab-delimited.
The image is saved as an image separate from the original
|mage- ' File Name

[ camera Model m
] Shooting Date/Time

g Shooting Mode

[ Photo Effect Mode

\J T(shutter Speed)

| Av(Aperture Value)

[ Metering Mode

:' Exposure Compensation 1
_ Digital Exposure Compensation v
( Select All ) € Deselect All
File Name
Save To: Macintosh HD:..._1000:xxx_100 | Browse... ]

A single file is created for 10 images.
The file name is given a sequence number.

- ~ ~
[ Cancel ) < Back ) Finish

A

The shooting information is saved as a text file (extension
“TXT").
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Organizing Images Using High-Level Functions

You can organize images using high-level functions such as setting
keywords and entering comments, renaming multiple files in a single
operation and classifying images by shot year/month/date, all of which
are useful when organizing your images.

Setting Keywords in Images

You can set keywords to identify images. The set keywords are also
useful when searching for images (p.46).

Select an image.

Select the [Edit] menu » [Keyword] P> [Settings].
The [Keywords Setting] window appears.

Select the keyword(s) and then click the [OK] button.

8e8en Keywords Setting
People Places Events Others
'_: Family ; Home ; Party
[ children ) Beach _ Holiday
. Friends J city _ Birthday

Check or uncheck the boxes to change the way Keywords are applied to the selected images. To
add a new Keyword to the system, type the name in the text field below the desired category, and

press the [+] button.
C S m

The keyword is set in the image.

Entering Comments into Images

You can enter information relating to images as comments. The entered
comments are also useful when searching for images (p.46).

Display the [File Information] window (p.41).

Click the [Advanced View] button.
A field for entering comments is displayed.

Enter text and then press the <return > key on the
keyboard.

re © ©  File Information
2
¥ Star Rating
(Y v
¥ Comment
(" Hide Detail )
[ File Name: .IMG_DOOI
¥ Keyword Modified: O 20 DO KO0
( View/Modify Keywords Y File Size: 7.0 MB (7,302,842 Bytes)
Image Size: 3888 x 2592
¥ Brightness Histogram Data Type: JPG
Sound:
Lock: (]
i
( < Back ) ((Next> )
L. 4
| Z

The entered text is saved in the image.

 ——

Introduction

Table of
Contents

Basic
Operation

Advanced
Operation

Preferences

Reference

Contents
Lookup

Index

00
©

43




Saving Multiple Images with New File Names

You can copy multiple images and save them with new file names in a
single operation.

Select all the images you want to save with new file
names (p.10).

Select the [File] menu P> [Organize Image] P
[Rename].

The [Rename] window appears.
Enter the file name and click the [OK] button.

P ™y
Rename

Select the post-conversion file name type.
™ Copy Image
) New Name + Number
C} Shooting Date + Number

) New Name + Shooting Date + Number

S Shooting Date + New Mame + Mumber

New Name: [ ]

Number:
Specify Number of Digits 3 2
Specify a Start Number 1

Example:

_001.xxx

(The same extension as the original is entered in xxx)

—

Images separate from the original images are saved with the new
names.

Classifying Images by Shot Date

Multiple images can be classified into different folders according to shot
date.

Select all the images to be classified (p.10).

Select the [File] menu P> [Organize Image] P [Sort
Images].
The [Sort Images] window appears.

Select [The files will be separated into folders for

each shooting date.] and then click the [Next] button.

' ™
Sort Images

Select the sort method for the selected image's folder.

(e The files will be separated into folders for each shooting date. )

() The files will be organized by Star Rating.

The [Organize by Shooting Date] window appears.
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Specify the folder structure, the file names, and the
save destination, and then click the [OK] button.

-

Organize by Shooting Date

-

The files will be separated into folders for each shooting date.

Save To:

A new folder will be created in this folder.
MacOSX Users:canon:Pictures:xxxx_xx_xx:xx... {  Browse... )
e i e

Sort Folder Settings:

Based on the following settings, a new folder is created, and
the images are sorted by each of their shooting dates.

Folder Name: " YearMonthDate | :]

New Name: 4 € Edit... )

MacOSX:Users:canon: Pictures:

B 30 _pnnonen _xx_01:2006_12_12

Copy/Move Images Setting

® Copy

—~
_ Move

- ~
| Cancel )|

<Back )[( oK )

Images are classified by shot date.

Settings for Folder Structure

Setting Item
YearMonthDate

Year/YearMonthDate

Year/Month/
YearMonthDate

Year/NewName

NewName/
YearMonthDate

YearMonthDate/
NewName

Description

Classifies images by creating a first-level folder
according to shot year/month/date.

Classifies images by creating a second-level
folder for the shot year, and the month and date.

Classifies images by creating a third-level folder
for the shot year, the month, and the date.

Classifies images by creating a new folder with a
new name inside the shot year folders.

Classifies images by creating folders for shot

year/month/date inside a folder with a new name.

Classifies images by creating a new folder with a
new name inside the shot year/month/date
folders.
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Searching for Images

You can search for images by ratings (p.17), shot date, comments (p.43)
and keywords (p.43).

Select the [File] menu P> [Search].
The [Set Search Criteria] window appears.

Specify the search criteria and then click the [Search
Now] button.

aYa) (&) Set Search Criteria
Specify Search Folder:Macintosh ...Pictures:xxxx_xx_xx:xxxx_xx_01
) Match all conditions () Match any conditions
v ™ Favorite photo
Images with the following star ratings will be searched for.

» [IDate
» [l Keyword

» [ Comment

( Cancel )' W'/

The search begins and the images that match the criteria are
displayed in the [Search Results] window.

Click the [Finish] button to close the [Search
Results] window.
The display returns to the main window.

Check the searched images in the main window.
The searched images are displayed in the main window. Also,
the [Search Results] folder is displayed in the folder area, and by

)

Introduction

Table of
selecting this folder, you can display the searched images at any Contents
time.

[ '.n ImageBrowser File Edit View Internet Window Halp 4 Tue 10:09 AM Q) -
?“!.‘b:ﬁ i S—— | Browser Windew Bas|c
T N Operation
- Favorite Folders | A1 Folders
o Advanced
Operation

view |5 e oot e——p— &, scamgge | | 3 3 H

Add " Canon Camera  View Image Sligeshaw CANGH MACE Prist&Emal  Send 1o Trash
CATEWAY

The images inside the [Search Results] folder are stored until
you either perform another search or quit IB.

Any work you do on images inside the [Search Results] folder will
be applied to all the original images. Therefore, please be aware
that if you edit or delete images inside the [Search Results]
folders, the original images will be edited or deleted also.
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Performing Advanced Editing

This section explains image editing using high-level functions based on
the assumption that you are familiar with handling standard image
editing software.

JPEG images deteriorate slightly when edited and saved, and the image
before editing cannot be recovered. For this reason, an edited JPEG
image should be saved as a separate image from the original image.

|§| You can edit RAW images in Digital Photo Professional (hereinafter,
“DPP"). Select the RAW image in the Main Window and select the
[File] menu P [Process RAW Images by Digital Photo Professional],
which will start up DPP. For detailed instructions on using DPP,
refer to “Digital Photo Professional Instruction Manual” (PDF
electronic manual).

Adjusting the Color of an Image in RGB

You can adjust the color of an image in RGB (red, green, blue).

Display the image to edit in the viewer window (p.16).

Click [Edit] and then select [Color/Brightness
Adjustment] in the menu that appears (p.25).
The [Color/Brightness Adjustment] window appears.

Select the [RGB Adjustment] tab sheet and adjust

the image.

Color/Brightness Adjustment

l{ RCB Adjustment IlCa\ar Adjustment -

== A—
Red
.... nd )
Green = 0
.... b
Blue =t
.... & :
_| Show Original iImage Undo Al Undo Redo
(] cancel ) (—GK‘)
Display Size: 3888 x 2502 y

Drag to the left or right to adjust

> The image is adjusted.

5 Save the image as a separate image (p.26).

1‘ Check the adjustments and then click the [OK]
button.
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)

Save as a separate image (p.26).

Introduction
Adjusting the Brightness Level Adjusting the Tone Curve
You can adjust the level of brightness (balance). You can adjust the brightness, contrast and color of a specific area by Table of
changing the tone curve. antgnots
Display the image to edit in the viewer window (p.16).
Display the image to edit in the viewer window (p.16).
Click [Edit] and then select [Level Adjustment] in the OpBe?Zit‘i’on
menu that appears (p.25). Click [Edit] and then select [Tone Curve Adjustment]
The [Level Adjustment] window appears. in the menu that appears (p.25).
. . The [Tone Curve Adjustment] window appears. Ad d
Adjust the image. _ [ ’ ] PP Op\(/a?gt(i:gn
Adjust the image.
{reB |3 R o Higha®evel
Output: ¢ Fun nS
Preferences
I—
ﬂD = “ [l shew Original Image Undo All Undo Redo Reference
3888 x 2502 | [
Drag right to adjust Drag left to adjust — — %) o
Drag to the left or right to adjust CfJ},‘{fﬂ{,S
The image is adjusted. Click to add a [ M ] (point)
) _ Adjust by dragging [l ]
Check the adjustments and then click the [OK] . o
button The image is adjusted. Index
' The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [l ] is 10.
To delete a [H ], press the < delete > key on the keyboard.




Check the adjustments and then click the [OK]
button.

Save as a separate image (p.26).

Transferring Images to Other Image Editing Software

You can transfer images to image editing software other than IB.

J1

O

In the main window, select the [ImageBrowser] menu

» [Preferences].
The [Preferences] window appears.

From the menu, select [Register Application] and
then click the [Add] button.
The [Application Selection] window appears.

Select the image editing software to transfer to, and
then click the [Open] button
-» The selected software is registered.

Click the [OK] button and then close the
[Preferences] window.

Select the image you want to transfer to the image
editing software.

Select the [Edit] menu p [Edit with Registered

Application] > image editing software to transfer to.
The selected image editing software starts up and then image is
displayed.
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Merging Images to Create Panorama Images

You can merge up to four JPEG images to create panorama images.
For merging images, start up the image-merging software “PhotoStitch”
from IB and use.

1 Select multiple images to merge (p.10).

2 Select the [Edit] menu P> [PhotoStitch].
=» PhotoStitch starts up and the main window appeatrs.

Check the arrangement of the images to be merged

and click the [2. Merge] tab sheet.
© If the arrangement of the images to be merged is not correct,
drag the images to rearrange them.

(@06

Photostitch ]

Merge Images Shot in Stitch Assist Mode
Click [2. Merge] to merge these images. I
For images shot as a 360-degree panorama, click [Arrange], select
[360 Degrees] and then click [2. Merge].

1. Selection and Arrangement | 2. Merge

L)

Enlarge

STITCHO1.JPG STITCHOZ.JPG

STITCHO3.JPG

STITCHO4.JPG

e

MNo. of Images: 4 1024 x 768 True Color )

=» The window switches to the [2. Merge] tab sheet.

4

Click [Start] to merge.

(@06

PhotosStitch )

Merge Images
Click [Start] to begin merging.

L+

Enlarge

STITCHO1.JPG

I f

STITCHOZ.JPG

STITCHO3.JPG STITCHO4.JPG

G
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-» The images are merged and displayed.

Click the [3. Save] tab sheet.
=» The display switches to the [3. Save] tab sheet.
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|§| See also the Help that are displayed when you click [

Check the save range and then click [Save].
(606

Photostitch ]

Save Image

Click [Save] to save the merged image. To merge a different image,
return to [1. Selection and Arrangement], click [Clear] and then [Clear
Alll.

1. Selection and Arrangement | 2. Merge

= LH)

Adjust Image... Enlarge

Irnage Size : 2657 x 734 A

Save range
Drag [ m ] to change the range

The [Save As] dialog box appears.

Specify the save destination and then click the
[Save] button.
The merged images are saved.

Select the [PhotoStitch] menu P [Quit PhotoStitch].
PhotoStitch quits.

] on the
right of the window for information on operating PhotoStitch and
PhotosStitch functions.

Adding Sound to Images/Playing Back

You can add sound to images and play back sound which you have
added to images with a camera that has a sound record function.

)

Introduction

Table of
. Contents
Adding Sound to Images
You can add a sound file to an image. .
A Mac OS X function is used for sound recording. When inputting sound Basic
. . Operation
from external equipment, connect the external equipment to your
computer beforehand.
. . Advanced
Select an image to which you want to add sound. Operation
Select the [File] menu P> [Sound] P> [Record]. ]
. . \ Higha®evel
- The audio recording dialog box appears. ,:uanS
2 Click[ @] (recording button) and begin recording the
sound to be added to the image. Click the [Save]
button to stop recording. e
=» The recorded sound file is added to the image. The [E,EI Jiconis
displayed in the image to which the sound file was added.
Reference
Playing Back Sound
Contents
You can play back sound files that are attached to images. Lookup
Select an image to which a [[J] ] icon is attached.
Index
Select the [File] menu P [Sound] P> [Play].

The sound is played back.
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4 Preferences
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Preferences

You can change any of the IB functions in the preferences window.

Check the settings displayed for each window before making changes.

Select the [ImageBrowser] menu P [Preferences].

From the menu, select the dialog box you want to
display, specify your settings, and then click the
[OK] button.

Preferences

( Browser Window |

ar

0|

Color Scheme

Preview Area

Background Color l:|

Thumbnail Area

Frame Color
Selection Color

Background Color

Custom lcon

m

[l Create Custom Icon for Images
Color Management

[_! Adjust Image Colors Using a Monitor Profile

( Cancel \'\'( 0K -)'

Browser Window Settings

You can change the background color of the main window (browser
window) as well as the color of the thumbnail image frames.

You can also make settings for color management.

Preferences

Background Color I:l

Custom lcon

[_| Create Custom Icon for Images

Color Management

"] Adjust Image Colors Using a Monitor Profile

" Browser Window & !
Coler Scheme
Thumbnail Area Preview Area
Frame Color I:l Background Color I:l
Selection Color
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Introduction
Viewer Window Settings Confirmation Dialog Box Settings
You can set the shooting information displayed in the viewer window You can set the software so that confirmation dialog boxes displayed Table of
(p.62). after each operation are not displayed. antgnots
The items you uncheck are not displayed.
Preferences
[ Viewer Window ) Breferences Basic
Select the shooting information you want to be displayed in the Viewer Window.  Confirmation Dialog Box [+] Operatl ol
; File:Naime m Display a message dialog box in the following cases
[ Camera Model
[ shooting Date/Time
E Shooting Mode EWhen placing a folder in the trash Ad\/an Ced
& Photo Effect Made [ When a search results folder is displayed Operatl on
E TviShutter Speed)
E Av(Aperture Value) EWhen filter settings have been changed
[ Metering Mode ) i ith Vi
E Expinsuirs Compersation When carrying out RAW development with Viewer .
[ Digital Exposure Compensation i ™ When playing a movie containing rotation information ng h 'L..eVeI
[ Autoexposure Bracketing Y Functions
( Select All 3 € Deselect All
( Cancel ) ( 0K )
C ) D Prefgf@nces
Reference
Contents
Lookup
Index

00

"2 To display the shooting information in the viewer window @)
In the viewer window, click the [Show Shooting Information] button et
(p.62) and in the menu that appears, select [Show Shooting Information]

to display the shooting information. 54



Processing When Rotating Settings

You can make settings related to image rotation.

Preferences

[ Processing When Rotating | :j

Rotation process when a JPEG image is downloaded from a camera
I Rotate an original JPEG image

A JPEG image that was rotated in the camera contains rotation information in the shooting
information.

However, if an image has original decision data appended, the actual image will not be
rotated.

(: Cancel ) ( OK

Layout Print Settings

You can make settings for layout printing.

Preferences

| Layout Print |

<
-

Item to print in caption
| Shooting Date
| Shooting Time
I File Name

Length

inch &

( Cancel :n(

Photo Print Settings

When printing with the [Photo Print] window (p.13), you can set whether
to trim the image and print with no borders around the paper, or to print

as is without trimming.

Preferences

| Phato Print |

ar
-

Trimming Settings

® Automatically trim to remove extra white space

) Do not trim

( Cancel

3=

oK

)

Register Application Settings

You can register other editing software.

Preferences

| Register Application A

menu.

A registered application can be run using [Edit with Registered Application] in the [Edit]

Delete

( Add... )

( Cancel

B

0K

)
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Troubleshooting

If IB is not operating correctly, refer to the items below.
Also refer to the Help from the [Help] menu or click the [?] button at the
top of each window and refer to the Help displayed.

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges.

For how to log in and how to specify Administrator settings, refer to
the User’s Manual for the Macintosh computer or for Mac OS X.

IB does not work

IB does not operate correctly on a computer if its system
requirements does not meet. Use IB on a computer with compatible
system requirements (p.59).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.59), if other applications are running at
the same time as IB, you may not have sufficient RAM (memory). Quit
any applications other than IB.

The software preferences file may be corrupted. Quit all applications
and follow the procedure below to delete the preferences file from the
[Preferences] folder before restarting IB.

In the hard disk drive where the system is saved, open the [Users]
folder P folder of the logged in user P [Library] folder B> [Preferences]
folder, and delete the preferences files below.

Preferences Description

Preferences file for the
ImageBrowser

com.canon.lmageBrowser.plist

com.canon.RAWImageTask.plist Preferences file for the RAW
Image Task

Preferences file for the
PhotoStitch

com.canon.PhotoStitch.plist

Images do not display properly

Images that are not supported by IB (p.59) do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif
compatible images may not display properly.

With initial settings, the color of images that have been shot in Adobe
RGB appear weak. In this case, check the [Browser Window] window
in preferences and checkmark [Adjust Image Colors Using a Monitor
Profile] (p.53). Color management is performed and the color of the
image shot with an Adobe RGB setting and the image shot with an
SRGB setting are matched.
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Deleting the Software (Uninstalling) et
Quit gny applications before gnmstallmg the software. ) ] ® You cannot retrieve data that you have emptied into the Trash
To uninstall the software, log into the account used when installation and deleted, so be particularly careful when deleting data.
was performed. . You cannot install the software again if you have just moved the Table of
To prevent computer malfunctions, always restart your computer after [ImageBrowser] folder to the trash. Be sure to select the [Finder] Contents
you have uninstalled the software. menu P [Empty Trash].
Display the folder in which the software is saved. Basic
Open the [Canon Utilities] folder. Operation
808 + Applications -
[« - [@= o)[#-] a
@ renre _ Advanced
| T4 macosx o .
(e < A - Operation
= % Q ©
E Da[a:GZ Preview QuickTime Player safari H i g h _Level
g Desicop Functions
,'s Sherlock Stickies System Preferences
|8 s
Music / |
ié pictures Tttt vdlites L conon uities 2 Preferences
£ 40 items, 216.19 G available v
Drag the [ImageBrowser] folder to the Trash.
Reference
Select the [Finder] menu on the desktop P [Empty
Trash].
The software is deleted. Cf_OﬂtEntS
ookup
Restart your computer.
Index

00
©

58



System Requirements

(O Mac OS X 10.4 to 10.5

Computer | Macintosh with one of the above OS installed
CPU PowerPC G4, G5 or Intel processor

RAM Minimum 256MB

Display Resolution : 1024 x 768 or more

Colors : Thousands or more

This software program is not compatible with UFS (UNIX File System)

formatted disks.

Supported Images

Image type Extension
JPEG images shot with a Canon digital
JPEG images | camera (Exif 2.2 or 2.21-compatible JPG, .JPEG
JPEG images)
RAW images shot with a EOS DIGITAL .CR2
RAW images | camera excluding EOS D6000, EOS TIF
D2000, EOS DCS1, EOS DCS3 .CRW
TIFF images | Exif-compatible TIFF images TIF, .TIFF
BMP images | Bitmap images .BMP
PICT images | PICT images PICT

About RAW Image Task

RAW Image Task is the RAW image editing software linked with IB.
RAW Image Task is not provided with IB ver. 6.2, but if it is installed
on your computer, it can be started up from IB ver. 6.2 in the same
way as from versions 6.1 and earlier.

RAW Image Task is not compatible with RAW images shot using an
EOS 50D.
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List of Main Window Functions

Preview Mode

Folder area*t

Image display area

(@06

.' ImageBrowser File Edit View Internet Window Help

L; Browser Window

4 Tue 10:09 AM

o)

Images acquired from your camera
can be accessed here

[ Favorite Folders |

All Folders

[ Movies
vﬂg Pictures
[ iphoto Library
i oo _xx_xx
L; 000 xx_01
[ e _xx_02
[0 soxx_xx_03

000,004

[ Preview Mode |

List Mode

¥ Basic
File Name:
Madified:
File Size:
Image Size
Data Type:
Sound:

Lock

IMG_0001
O R X KX

7.0 MB
3888 x 2592
PG

=

m

¥ Star Rating

frie ]

e/

¥ Comment

¥ Keyword

( View/Modify Keywords... )

¥ Brightness Hsitogram

A

Filter display
(p.18)

\_ IMC_0001.JPG

IMC_0002.JPG

IMG_0003 JPC IMC.

0004 JPG

IMC_0005.JFC

IMC_|

0006.J9

€

View | 9% ier Tool [T?T 3 LtL'| Selz((\ngl Images |:¢!’] £ =l

J4>

Enlarges/
reduces the
thumbnail
images (p.11)

Canon Camera

View Image

o

Slid

Show

.

CANON IMAGE
CATEWAY

=, 8

Print & Email Send to Trash

Information display area

Thumbnail image

display area*?

Shows/hides the folder area
Shows/hides the task buttons
Shows/hides the

information display area

Selects/deselects all the
images

(o. of Images selecred: 1 / Toral lﬁlmages)zl— Number Of Selected |magesl

Starts up EOS Utility/Displays
Download images window

Viewer window (p.62)
Slide show (p.32)

(p.7, p.9)

Connects to the CANON iMAGE GATEWAY*3

1 Images in folders selected here are displayed on the thumbnail image display area.
*2 |Images selected here are displayed on the image display area.
*3 The [CANON iIMAGE GATEWAY] button may not be displayed depending on the area you are in.

Deletes images and folders (p.23)
Prints images and creates images for e-mail (p.13, p.33, p.37, p.38)

Total number of images

)
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List Mode

" ImageBrowser File Edit View Internet

(@06

Window Help

[ Browser Window

4 Tuel0:09AM @ |
]

Images acquired from your camera Preview Mode I-—hst-ﬂed?—"j
can be accessed here

(" Favorite Folders | All Folders

(

|G search Results
l:ﬁ Movies
@ Photo
v[& Pictures
[ iPhoto Library
Wi X _xx
7 uxxx_xx_01
[7 xxxx_xx_02
[7 uxxx_xx_03
L; xxxx_xx_04

IMG_000L.CR2

IMG_0006.CR2

Folder area*! —

IMG_0011.CR2

Ch 5

IMG_0013.CR2

RAW image icon

;

Bracketing icon

IMG_00D05.CR2

Image display area

uE Protect icon
IMG_0010.CR2 . . .
i r-“} Audio recording icon

IMG_0014.CR2 IMG_0D15.CR2

Shows/hides the folder area
Shows/hides the task buttons

Filter display ”
(p.18) | | 2 i
e View J:? Filter Tool ( L G’ A Q @.} Selmmlg Images | _{I =l S I t /d I t ” th
Enlarges/ e : . elects/deselects all the
redUCGS the Add to Favorites Cann%%mera Vit\%ag: S\igaw c&gﬂoj‘;‘:m:f Prin%h;l Sendé.:'msh Images
thumbnail ( No. of images Selected: 0 { Total: 17 images )-—— Number Of Selected |magesl
images (p.11 N ) ;
ges (P11 Starts up EOS Utility/Displays Slide show Deletes images and folders (p.23) Total number of images
Download images window (p.32) Prints images and creates images for e-mail (p.13, p.33, p.37, p.38)

(p.7, p.9) Viewer window (p.62)

1 Images in folders selected here are displayed on the image display area.
*2 The [CANON iMAGE GATEWAY] button may not be displayed dependin

Connects to the CANON iMAGE GATEWAY*?

g on the area you are in.
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List of Viewer Window Functions

Display magnification
(p.17)

(806

& IMG_0001.JPC (1/18)

" Fit to window

My W

Switches
between images

. - . e
5 ﬁ %I
4 2 ‘ E: ﬁ - Nur 5 & T
Back Mext Save Edit Displays Synchronize  Full Sereen — Primt iR
(Image Size: JBBE x 2592) | | (Dlsplay ) %) A

Displayed image size

Saves the images (p.26)
Edits the images (p.25)

Split displays (p.40)

Synchronize (p.40)

Display magnification

Photo print window (p.63)
Full view display (p.12)

Image display area

Rating (p.17)

Shows/hides the
shooting information
and AF point

(p.12, p.16)
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List of Photo Print Window Functions

Printer selection and settings

(@06

Photo Print

Printer

" Canon XXX F“H

Page settings

Shot date and
time settings

& Page setup... )

Paper size :
Ad
Click [Page Setup] to enable

borderless printing on
supported printers.

Shooting Date/Time

— MNone l":‘]

Properties...

Trims the image

5ml Remove unwanted regions
==r | of your photo.

Add some text to print
with this photo.

E‘ Image: 1/1

fal
1 L] Total :

1 pages

(C

Close ) ( Print

)

A

Switches the printing image

Number of prints

Print preview

Inserts text

)
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List of Index Print Window Functions

Printer selection
and settings

Page settings

Print information
settings

rB 06 Index Print )
Printer Preview
Name: R R ——=- 4
*: Canon XXX |+] i
l.: Page setup... :’J i
Paper size : |
A4
Orientation: Portrait |
On printers that support borderless P i
printing, this feature is not e i
recommended.Click [Page Setup] to !
change this setting. |
Copies: 1 E i
Page Layout Settings = |
Rows: 3 @ i
—= |
Columns: 2|1+ S R EE R R TN |
£ Page Caption Settings ) =
.l"’ .
M shooting Information 7 g i
: & | @
"] Header / Footer e
— Rotate Left Rotate Right Trim Image
Settings...
( Close ) l.: Print :'J
P

Switches the printing page

Rotates the image

Print preview

Trims the image

)
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List of Layout Print Window Functions

Sets the printing
style

Printer selection
and settings

Page settings

(@06

Layout Print

Print Style

' Custom layout printing

7

Printer

Name:

' Canen XXX

N

( Page setup...

Paper size :
Ad

Orientation: Portrait

Click [Page Setup] to enable
borderless printing on supported
printers.

Preview

— Print preview

Sl ) = 3
S B | W 0 =
Rorate Left Rotate Right Trim Image Images Be-Layout Clear
per Page
( Cibse ) Save )  Prinl )

Rotates the image

Trims the image

Deletes an image

Reverts to the original condition

Number of images per page

G
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Introduction
Contents Lookup
. - Table of
Downloading Images to Your Computer Image Editing Contents
Download images by connecting your camera Use automatic adjustment ->p.25
and computer 2p7 . . :
Adjust brightness/darkness -»p.26 Basic
Download images using a card reader - p.8 Make colors more vivid -p.26 Clpeiggiie
Image Checking Trim parts of an image = p.27 .
Look throuah - p.10 Specify an aspect ratio that matches the size of - p.27 Operation
9 . P the paper on which an image is to be printed P
Enlarge and view = p.11, p.16 Make an image sharp - p.29
P High-Level
Check efficiently 2 p.19 Insert text = p.28 Fugnctions
Compare multiple images = p.40 ® Correct red-eye - .30
Check the shooting information such as shot
date 2 pal ® Merge = p.50 Preferences
View as a slide show = p.31 Utilizing Images
Image Printing Attach an image to an e-mail -»p.33 Reference
Print one image on one page > n.13 ® Make !nto computer wallpaper - p.34
Arrange multiple images on one page and print =» p.37 @Make into a computer screen saver 2p35 RSN
Arrange images freely and print = p.38 Converting Images Lookup
Organizing Images Change the size = p4l
Sort by rating - p.17 Convert to a different type - p.4l Index
Move to a different location = p.21
Move by entire folder to a different location =>p.21 @ @
Change the file name = p.22
Delete = p.23 @
Classify by shot date - p.44
Search - p.46
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A
Adding SoUNd 10 IMAGES.........uuiiiiiiieiiiii e 51
AdJUSt JPEG IMAQGES....uuuuiuuriiuiiiiiiiiiiiiiriirsrrerinesrrerrsrreeesreer. 25, 47
Adjusting (JPEG or TIFF IMage)..........uuueeueemimeeiieiiieiieieeeeeeeeeeeeeeee 25, 47
AdiuStiNg IN RGB ... 47
Adjusting the Brightness............ooooooi s 26
Adjusting the Brightness Level ... 48
Adjusting the Saturation ..............cccoooe 26
Adjusting the Sharpness ... 29
Adjusting the TONE CUIVE .........oooiiiiiiiiiiee e 48
Automatic Adjustment ... 25
COorrecting REA-EYE ........uuuuiiiiiiiiiiiiiiiiiiiiieiieeiieeeieeeeeeeeeeeeeeeeeeeeeeeees 30
Adjusting the Brightness ..........covviiiiiiiiiee e 26
Adjusting the Brightness LeVel...........ccuuvviiiiiiiiiiiiiiiieeiieeiieeeeeeeeeeveeee 48
Adjusting the Saturation....................eeeeeeiiiiiiieeieeeeeeeeeeee e 26
Adjusting the SharpneSsS..........uuuiiiiiiiiiiiii e 29
Adjusting the TONE CUIVE .........uuiiiiiiiiiiiiiiiiiiiiiiieeeieeeee e 48
Attach an Image to an E-malil................uuuuiiiiiiiiiiiiiiiiieiieieeeeeseeeeee e 33
AUutoMatic AJUSTMENT ...t ene e eeees 25
B
Batch Change the File Name of Images..............uuvvueeiieiiiinieeiiieieneeee. 44
Browser WiNAOW ..........couuiiiiiiiiiiiiieeeee i —>Main Window
Browser Window Settings (Preferences) ..........ueeveeeeeeeeeeieeeeiieieeieeeeeen. 53
C
Change File Name ..., 22
Change Folder Name...........cccccvviiiiiiii 22
Change the Display Magnification ............cccccco 11
Changing the Size and Type of an Image and Saving....................... 41
Checking the Shooting Information..............ccc 41
Classifying the Images by Shot Date............ccccoeeoeiiii e, 44
Color Management ..........covviiiiiiiiieee e 53
Compare Multiple Images......ccccvvveiiiiie 40
Confirmation Dialog Box Settings (Preferences) ........cccccvvvvvvvieieneeenn. 54
Correcting Red-Ye........ccovvviiiiii 30
Creating @ FOIEN ..o e e 20

D
Delete
Delete FOIAEIS. .. ..o 23
Delete IMAgeS.......ccviiieeeie e e 23
Delete the SOftWare ............eevviiiiiii e 58
Delete FOIAEIS ...t eeeeeeeeees 23
Delete IMAGES .....eieeiiiiiiiit bbb aesseessreseeeseeeeeees 23
Delete the Software (Uninstalling) ................eevveeeiimeiiiieeeiiiiiiieeeeeeeeeeene. 58
Deleting the IB (Uninstalling) ............cccvivuiiiiiiniiiiiiiiiiiiinerieniierreeneeenee. 58
Displaying Images Shot with Adobe RGB ...............uveiiiiiiiiiiiiiiieiieeeee. 57
Downloading an Image to Your COMPULET ...........euvvevreerrerirereeereeenennnens. 7
Downloading Images from a Camera ...........cccveeeeeeeniiiiciiiiieeeeeeens 7
Downloading Images from a Card Reader............ccccoovevvivieeeeeennns 8
Downloading IMAgES ..........uuuuuuueiuiiiiiiiiiiiiiiniiiiieererraerrrrerrerererr .. 7
Downloading Images from a Card Reader .............occcvvvveeeeeeiiiiiiinienen. 8
E
Editing...ccooiiiiiii e e - Adjusting
ENnlarge IMages .......ccciieeiiiicc e 11,17
ENtering COMIMENTS.........oviiiiiiiiiiiiiiiiee et 43
Exporting Shooting INformation ...............cceeuvvviieeieiieieiiieiieeeeeereeeeeeee e, 42
F
Favorite FOIOErS. ..o 23
FUIl VIEW DISPIAY ...t 12
I
T o L=y = 11 111 o SRR 37
INSEIT TEXE. .. e e e e e e e e 28
INserting TeXt iNtO IMAQJES ......uuuuurieiiiiiiiieeieeiiieieeee et eeeeee e eeeeeeeeees 28
K
KeYWOrdS SEtlNGS......uuviiiiiieeiiiiiiiiieee e 43
L
Layout Print Settings (Preferences)..........occcvvivvieeeiiiiiiiiieeeee e 55
Layout Printing.......ccoceieeiei e ee e eeaeees 38
List Mode (Main WiNAOW) ..........ccommmiiiiiiiiiiiiiiiiieieeeieeeeeeeeeeenees 10, 61
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M

Main Window (Browser Window) ................eeveeeeeeiieeieeeeeeeeeeeeeen. 7,60, 61

Merging Panorama IMagesS...........uuuuurururiririiiriieerinrrieereersrrreeeeeerereeee. 50

Move OF COPY FOIAEIS. .. ... 21

MOVE OF COPY IMAGES.....iiieiieeiiii et 21

N

NaVIgator WINQOW ... eenaennees 17

@)

Operating with EOS ULlity ......oooovviiiiiiiii, 7

P

Photo Print Settings (Preferences) .........ccccvvvvvvvvviviieiivenireneeeeeeneeneenne. 55

PROtO Printing ...ooooooe oo 13

Playing Back SOUNG.............uuuuiuiiuuiiiiiiiiiiiniiieiiiiensrrenersrensrrrreeerere.—. 51

PrEIEIBINCES. ... ettt e e e eees 53
Browser Window Settings ..., 53
Confirmation Dialog BoX SettingS............euueeeieeiiiiiiiiiiiiieeiieeeeeenen, 54
Layout Print SEtlNGS . ...cooviiiiiiiiieee e 55
Photo Print SettingS.......covveviiiiiiiii i 55
Processing When Rotating Settings.........cccccvvvveeiiiiiieceeeee e 55
Register Application Settings ........cccccvvvvvviiiiiiiie 55
Viewer Window SettingsS........ooooeeieiiiiiiiie e 54

Preview Mode (Main WINAOW) .........ccoovriiiiiiiiiiiie e 9,19, 60

Printing
FaTo =3 d 10111 T R %7
I\ o 10| = 1] 1 Vo PP 38
PROTO Printing ......cvviiiiiiiei e 13

Processing When Rotating Settings (Preferences)........ccccccvvvvevvveeen.. 55

Q

QUITEING 1B .ttt e e 14

R

RATINGS et 17

Register Application Settings (Preferences) ........ccccccveeeeeveeeevveeviinnnnnn, 55

S

Searching for IMagesS........cccoiv v e 46

Setting @ SCrEEN SAVE.........coo e 35
Setting a Wallpaper ......coooooiiiii e 34
Setting an Image as a SCreen SaVer.......cccoeeeiveeiieeeeeeceeee s 35
Setting an Image as Wallpaper ........ccoooooooiiiieieee 34
SHAE SNOW.....iiiiiiiieee e 31
StArtiNg UP 1B . 7
SUPPOrEd IMAGES ..o 59
Synchronize DISplay ........coooeieiiiiie 40
System ReqUINEMENES ......coooiei e 59
T

Thumbnail Display (Main Window) ..........cccoovvviiiiiiiiiiieeeeeeeeeeeee, 10
Transfer Images to other Image Editing Software .............cccccvveeeennne 49
B 1010211 o T PRSP SSPPPRP 27
TrMMING &N IMAGE.....c it 27
\%

VIEW 8N IMAGE ... ..eeieiieii ettt e e 9
VIEWET WINAOW.......ceviiiiiieiiiiiiiiiiee e 12, 16, 62
Viewer Window Settings (Preferences) .......cccccovviiiiiiieeiiiiiiiieeeeeenn 54
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Macintosh is a trademark of Apple Inc., registered in the United States
and other countries.

Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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